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RESUMO 

 

Caffaro LAM. Efeitos da estimulação elétrica nervosa transcutânea na angiogênese e 

proliferação celular do carcinoma 4T1 de glândulas mamárias em camundongas 

[tese]. São Paulo: Faculdade de Medicina, Universidade de São Paulo; 2023. 

 

Diante dos efeitos vasculares e terapêuticos da TENS associados à escassez de 

estudos sobre sua aplicação prática em pacientes oncológicos, é necessária a 

realização de estudos pré-clínicos que avaliem a segurança oncológica da TENS. O 

objetivo deste estudo é avaliar os efeitos da Estimulação Elétrica Nervosa 

Transcutânea (TENS) na angiogênese, proliferação celular, na deposição de fibras de 

reticulina do carcinoma 4T1 de glândula mamária de camundongas. Camundongas 

Balb/c (N=30) foram divididas em três grupos e submetidos à inoculação de células 

4T1 e tratados por 20 minutos durante 10 dias: grupo de alta frequência (GA) e grupo 

de baixa frequência (GB) foram tratados com 100 Hz e 10 Hz respectivamente; e o 

grupo sham (GS) com os cabos desconectados. Os demais parâmetros da TENS 

foram: duração do pulso - 200 microssegundos (µs) e intensidade sensorial. A 

intensidade foi reajustada em 1,0 mA a cada cinco minutos nos grupos GA e GB para 

evitar a habituação da corrente. Os animais foram mortos por injeção de xilazina e 

quetamina seguidos da permanência em câmara de CO2. Os tumores foram 

extirpados para a confecção de lâminas de Hematoxilina e Eosina (HE), 

imunohistoquímica com CD31 e reticulina. O teste de Kruskal-Wallis mostrou que não 

houveram diferenças entre os grupos para a área fracionada de vasos sanguíneos 

(p=0,612). O teste de One-Way ANOVA não evidenciou diferença significante entre 

os grupos para a área fracionada dos núcleos celulares (p=0,152). Para a área 

fracionada de fibras de reticulina o teste post-hoc de Turkey de comparações múltiplas 

não detectou diferença entre GA vs. GB (p=0,708) e GB vs. GS (p=0,195), porém, 

houve diferença entre GA vs. GS (p=0,042). Conclui-se que a TENS não promoveu 

angiogênese, não influenciou a proliferação celular e, quando utilizada em alta 

frequência inibiu a deposição de fibras de reticulina. 

 

Palavras-chave: Camundongos. Estimulação elétrica nervosa transcutânea. 
Fisioterapia. Modalidades de fisioterapia. Neoplasias. Neoplasias da mama. 

 

 

 



 

 

 

ABSTRACT 

 

Caffaro LAM. Effects of transcutaneous electrical nerve stimulation on angiogenesis 

and cell proliferation of 4T1 carcinoma in mammalian glands in mice [thesis]. “São 

Paulo: Faculdade de Medicina, Universidade de São Paulo”; 2023. 

 

In view of vascular and therapeutic effects of Transcutaneous Electrical Nerve 

Stimulation (TENS) associated with the scarcity of studies on its practical application 

in cancer patients, it is necessary to carry out preclinical studies to assess the 

oncological safety of TENS. The aim of this study is to evaluate TENS effects on 

angiogenesis, cell proliferation and deposition of reticulin fibers in 4T1 carcinoma of 

mammary gland on mice. Balb/c mice (N=30) were divided into three groups and 

submitted to 4T1 cell inoculation and treated for 20 minutes during 10 days: high 

frequency group (HF) and low frequency group (LF) were treated with 100 Hz and 10 

Hz respectively; and the sham group (GS) with the cables disconnected. The other 

TENS parameters were: pulse duration - 200 microseconds (µs) and sensory intensity. 

The intensity was readjusted by 1.0 mA every five minutes in HF and LF groups to 

avoid current habituation. The animals were killed by injection of xylazine and ketamine 

followed by CO2 chamber permanence. The tumors were excised for preparation of 

Hematoxylin and Eosin (HE), immunohistochemistry with CD31 and reticulin slides. 

The Kruskal-Wallis test showed that there were no differences between groups for the 

fraction area of blood vessels (p=0.612). The One-Way ANOVA test showed no 

significant difference between groups for fraction area of cell nuclei (p=0.152). For the 

fraction area of reticulin fibers, Turkey's post-hoc test of multiple comparisons did not 

detect difference between GA vs. GB (p=0.708) and GB vs. GS (p=0.195), however, 

there was a difference between GA vs. GS (p=0.042). It is concluded that TENS did 

not promote angiogenesis, did not influence cell proliferation and, when used at high 

frequency, its inhibited the deposition of reticulin fibers. 

 

Keywords: Mice. Transcutaneous electric nerve stimulation. Physical therapy 

speciality. Physical therapy modalities. Neoplasms. Breast neoplasms. 
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1.0 INTRODUÇÃO 

 

De acordo com a Organização Mundial da Saúde (OMS), o câncer de 

mama é o câncer mais frequente nas mulheres e em 2020 acometeu 2.3 

milhões delas, levando à morte 685 mil (WHO, 2021). 

Pacientes que são submetidos ao tratamento cirúrgico para o câncer 

de mama podem apresentar quadro clínico inicial de dor e diminuição de 

amplitude de movimento (ADM) do membro superior. Se estas disfunções não 

forem tratadas, o paciente pode evoluir para complicações tardias como 

disfunções miofaciais, capsulite adesiva, disfunções nervosas e dor 

persistente (De Groef et al., 2015).  

Junto deste quadro, os pacientes ainda podem desenvolver linfedema 

relacionado ao câncer de mama (LRCM), o qual tem uma incidência de 14 a 

40% (Rockson, 2018) e é de origem multifatorial (McLaughlin et al., 2020). O 

linfedema pode causar efeitos negativos como uma diminuição na atividade 

física, alterações sensoriais, estresse psicológico, fadiga e redução na 

qualidade de vida (Merchant e Chen, 2015).  

Previamente a dor pós-mastectomia não era uma complicação 

frequente, porém, atualmente é estimado que de 20 a 50% dos pacientes 

tenham este sintoma (Tait et al., 2018). Reis et al. (2018) aponta que 

aproximadamente metade dos pacientes pós-cirúrgicos de câncer de mama 

recebem um tratamento pós-operatório indevido, possivelmente como 

consequência de uma avaliação inadequada da intensidade da dor destes 

pacientes. 

O trabalho de Okamoto et al. (2018) mostra que a dor pós-operatória 

intensa é um fator de risco para a cronificação da dor nestes pacientes. Seus 

resultados evidenciam que pacientes que relataram dores severas no primeiro 

dia pós-operatório tiveram um pior prognóstico, cursando com dores por mais 

de seis meses, quando comparados com o grupo de pacientes que declarou 

dores leves no primeiro dia pós-operatório, o que corrobora com Tait et al. 
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(2018), que apontam que a presença de dor aguda pós-operatória é um fator 

de risco forte para a presença de dor pós-mastectomia tardia. 

Diante deste quadro, a fisioterapia dispõe de uma série de recursos não 

farmacológicos que podem ser utilizados para o manejo da dor, dentre eles 

existem os agentes físicos como o calor superficial, diatermia por ondas 

curtas, crioterapia, estimulação elétrica nervosa transcutânea (TENS), 

ultrassom terapêutico, corrente interferencial, terapia por laser de baixa 

intensidade, entre outros (Cheville e Basford, 2014). 

Dentre estes agentes físicos, a TENS é um dos recursos de 

eletroterapia mais utilizados na prática clínica da fisioterapia. Segundo o 

estudo de Springer et al. (2015), 88,4% dos fisioterapeutas fazem uso da 

TENS, sendo que 47,8% a utilizam diariamente. 

A aplicação da TENS no pós-operatório de pacientes de câncer de 

mama pode trazer benefícios como a diminuição da incidência de necrose 

tecidual na ferida pós-operatória (Atalay e Yilmaz, 2009), a redução da dor 

pós-mastectomia (Erden et al., 2022), a diminuição da dor neuropática 

periférica induzida por quimioterapia (Püsküllüoglu et al., 2022), a redução da 

dor intercostobraquial e da disestesia em pacientes com síndrome pós-

mastectomia (Silva et al., 2014; Mendonça et al., 2017). 

Porém a utilização da TENS em pacientes oncológicos é polêmica. Sua 

aplicação é comumente realizada em locais distantes do tumor primário 

(Tonezzer et al., 2012; 2017) e se realizada sobre os tumores, a aplicação só 

ocorre em pacientes em cuidados paliativos (Nakano et al., 2019) ou com 

dores advindas de metástase óssea (Searle et al., 2009; Sampaio et al., 2016). 

Um dos fatores que contribui para as dúvidas da utilização da TENS 

em paciente oncológicos está relacionado ao aumento da angiogênese 

promovida pela utilização deste recurso, evidenciada nos estudos de Liebano 

et al. (2008), Machado et al. (2016) e Machado et al. (2017). 

A aplicação local de agentes eletrofísicos tem sido contraindicada no 

tratamento de pacientes oncológicos (Robertson et al., 2009; Rennie, 2011; 

Johnson, 2021). Segundo Rennie (2011), apenas a crioterapia é tida como 
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segura para aplicação local em tumores malignos, enquanto que os demais 

agentes físicos são contraindicados em aplicação local pela escassez de 

estudos sobre seus efeitos neste tecido. 

Segundo Rennie (2011), a aplicação da estimulação elétrica sobre um 

tecido maligno poderia promover o aumento da síntese de DNA e da atividade 

mitótica, levando ao crescimento tumoral e favorecendo o aparecimento de 

metástases.  

O aumento da taxa metabólica é relacionado ao aumento da 

temperatura tecidual de acordo com a lei de Van’t Hoff, em que o acrécimo de 

temperatura de 4°C acarreta em aumento de 50% do metabolismo (Robertson 

et al., 2009); porém, os estudos de Cramp et al. (2000) e Cramp et al. (2002) 

mostraram, em seus resultados, que a TENS não aumentou a temperatura 

tecidual em humanos saudáveis em nenhum dos grupos estudados. 

Wang et al. (2018) aplicaram TENS sobre câncer cervical em 

camundongos e seus resultados mostraram que não houve diferença 

significante entre o grupo controle e o grupo ativo para o crescimento tumoral, 

apoptose, proliferação e angiogênese. 

Portanto, diante dos efeitos vasculares e terapêuticos da TENS, 

associados à escassez de estudos sobre sua aplicação prática em pacientes 

oncológicos, é necessária a realização de estudos pré-clínicos que avaliem a 

segurança oncológica da TENS. 
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2.0 REVISÃO DA LITERATURA 

 

2.1 Microambienete tumoral (TME) 

 

Recentemente a abordagem relacionada ao câncer mudou 

drasticamente e este não tem sido visto apenas como um conjunto de células 

tumorais, e sim como um microambiente tumoral (TME) complexo, em que 

outras células não tumorais são recrutadas para promover um ambiente 

tumoral auto-suficiente (Peltanova et al., 2019). Dentre as células estromais 

que formam o TME estão os mastócitos, fibroblastos associados ao câncer, 

plaquetas, neutrófilos, macrófagos, células T reguladoras, células 

supressoras derivadas de mielóides e células matadoras naturais (Peltanova 

et al., 2019). 

Estas subpopulações celulares secretam citocinas, fatores de 

crescimento, proteínas da matriz extracelular (MEC) e quimiocinas para se 

comunicarem entre si e entre as células tumorais (Peltanova et al., 2019). 

Outros constituintes não celulares no TME são os restos metabólicos, 

exossomos, microvesículas, co-fatores, enzimas, componentes relacionados 

à MEC, moléculas sinalizadoras e secreções endócrinas e exócrinas 

(Peltanova et al., 2019). 

 

2.1.1 Progressão tumoral 

 

Células inflamatórias e tumorais interagem de forma propícia para a 

progressão tumoral. Com o crescimento tumoral ocorre a presença de hipóxia 

e necrose, causando assim o recrutamento de células imunes (Lorusso e 

Rüegg, 2008). 

Durante a progressão tumoral, os fibroblastos são convertidos pelo 

fator de necrose tumoral-β1 (TNF-β1) em fibroblastos ativos ou fibroblastos 
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relacionados ao câncer (CAF). Os CAFs são responsáveis pela liberação de 

moléculas imunes modulatórias e fator de necrose tumoral-α (TNF-α) 

(Sflomos e Brisken, 2017). 

As células imunológicas presentes no TME, quando recrutadas pelas 

células tumorgênicas, podem auxiliar na remoção de tecidos, na formação de 

novos vasos sanguíneos e no aumento da proliferação celular. Esse processo 

foi dividido em três etapas: a primeira envolve o recrutamento de células 

imunológicas (por meio de proteína quimiotática interleucina-8 (IL-8) e 

monócitos-1 (MCP-1)), que é induzido pela produção de citocinas. A segunda 

etapa é a cooptação, que ocorre devido à secreção de citocinas como a 

interleucina-6 (IL-6), o TNF-α e o fator inibidor da migração de macrófagos 

(MIF), que regulam a diferenciação das células imunológicas e promovem o 

desenvolvimento tumoral. Na terceira etapa, as células imunológicas 

diferenciadas geram hormônios, fatores de crescimento e citocinas que 

promovem a tolerância do tumor ao sistema imunológico e o seu 

desenvolvimento (Onuchic e Chammas, 2010). 

Os macrófagos associados ao tumor (TAM) são dominantes em relação 

à população de leucócitos no TME e, relacionados à proliferação, invasão e 

metástase das células tumorais, também atuam na supressão de células T, 

angiogênese e progressão tumoral (Onuchic e Chammas, 2010; Sflomos e 

Brisken, 2017). Estudos recentes correlacionam os níveis de infiltração dos 

TAM com um prognóstico ruim de carcinomas de células escamosas de 

cabeça e pescoço (Peltanova et al., 2019). 

Os adipócitos também têm papel importante na progressão tumoral por 

meio da secreção de hormônios como o estradiol (E2) e a prolactina 

aumentando a proliferação e sobrevida do câncer de mama. Junto disto, 

estudos in vitro apontam que a liberação de IL-6 por adipócitos deixam as 

células tumorais mais invasivas e aumentam o potencial metastático e, 

também estudos em in vitro e in vivo mostram a liberação de TNF-α por 

adipócitos e seus efeitos deletérios, promovendo acréscimo do número de 

células-tronco e metástase (Sflomos e Brisken, 2017). 
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2.1.2 Vascularização tumoral 

 

Vasos sanguíneos tumorais apresentam características que diferem 

das de vasos de tecidos sadios: são usualmente descritos como imaturos, 

suas paredes são mal desenvolvidas, por vezes com descontinuidades e com 

uma má comunicação entre pericitos e células endoteliais (Tozer et al., 2005). 

Estas características promovem uma maior permeabilidade vascular de 

macromoléculas (o que gera hemorragias) e, consequentemente, um 

aumento da pressão intersticial, que é aumentada pela drenagem linfática 

inadequada do TME (Carmeliet et al., 2005; Tozer et al., 2005; Moreira et al., 

2007). 

Também são evidenciados poros mais dilatados e com grande 

variabilidade de tamanho, vasos sanguíneos de formatos irregulares e 

tortuosos, pequena quantidade de células musculares lisas (causando baixa 

resposta para terapias medicamentosas vasoativas) e grande quantidade de 

“fins cegos” (gerando estase) (Carmeliet, 2005; Tozer et al., 2005; Moreira et 

al., 2007). 

Importante destacar que estes vasos sanguíneos possuem uma rede 

caótica sem organização hierárquica entre vênulas, arteríolas e capilares 

sanguíneos: o que acarreta em fluxo sanguíneo desordenado e 

consequentemente, uma grande quantidade de sangue desoxigenado e área 

de hipóxia tumoral, sendo que as áreas periféricas têm um aporte sanguíneo 

maior (Tozer et al., 2005; Moreira et al., 2007; Nagy et al., 2009). 

 

2.1.3 Fase avascular e troca angiogênica 

 

Durante a fase avascular, os tumores são considerados inativos e 

apresentam um fenótipo avascular, sendo nutridos por difusão. Neste período, 

há um equilíbrio entre a proliferação celular e a apoptose, permitindo o 
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aumento do volume tumoral até atingir 1-2 mm³ sem suporte vascular (ou 

quando possuem cerca de 106 células malignas), ou até aproximadamente 2-

3 mm³ de volume (Hoeben et al., 2004; Carmeliet, 2005). 

A essa fase segue-se o fenômeno da troca angiogênica, na qual o 

tumor, que anteriormente apresentava um fenótipo avascular, passa a ter um 

fenótipo vascular. Isso ocorre devido a um desequilíbrio entre fatores 

estimulantes e inibidores (Hoeben et al., 2004; Carmeliet, 2005). 

 

2.1.4 Angiogênese tumoral 

 

A angiogênese consiste na formação de novos vasos sanguíneos a 

partir do endotélio da vascularização pré-existente. Colunas de células 

endoteliais adjacentes ficam em contato entre si formando cordões que 

posteriormente vão desenvolver tubos com lumens (Wang et al., 2008).  

A angiogênese tumoral é um processo relativamente cru e de grande 

importância para o crescimento, progressão e metástase tumoral, sendo o 

resultado do desbalanço da secreção de citocinas, em especial o fator de 

crescimento endotelial vascular-A (VEGF-A). A expressão do VEGF-A induz 

a formação de vasos sanguíneos tumorais, sendo estes os “vasos mãe”, os 

capilares, as proliferações microvasculares glomerulóides, as más formações 

vasculares, as artérias alimentadoras e as veias drenadoras (Wang et al., 

2008; Nagy et al., 2009). As características anatômicas e cinéticas destes 

vasos sanguíneos são semelhantes independentemente dos tecidos em que 

eles brotam (Nagy et al., 2009). 

 

2.1.5 Fase vascular 

 

Durante a fase vascular, o VEGF desempenha um papel importante 

como mediador da angiogênese tumoral e desencadeia uma série de eventos 
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que, a partir da formação de capilares sanguíneos, proporciona aos tumores 

acesso a oxigênio e nutrientes, resultando no aumento do volume tumoral e 

em metástase subsequente (Hoeben et al., 2004; Carmeliet, 2005). 

A expressão do gene VEGF é regulada por inúmeros fatores, como os 

fatores de crescimento que se seguem: fator de crescimento derivado de 

plaquetas (PDGF), fator de crescimento fibroblástico (FGF), fator de 

crescimento endotelial (EGF), fator de necrose tumoral (TNF), fator de 

crescimento transformador-β (TGF-β) e interleucina-1 (IL-1). Outro 

componente que desempenha papel na indução de VEGF é a hipóxia, que 

parece ser onipresente durante o processo de crescimento tumoral 

(Carmeliet, 2005). 

Cria-se um ciclo de hipóxia, VEGF e crescimento tumoral no qual o 

crescimento tumoral, durante a fase avascular, aumenta a distância entre 

partes do tumor e os vasos sanguíneos, o que causa hipóxia; que, por sua 

vez, impede a degradação do fator-1α induzido por hipóxia (HIF-1α), 

permitindo a dimerização e ligação com o promotor do gene VEGF, o que 

estimula a produção de VEGF; e, provoca aumento da permeabilidade 

vascular e da angiogênese. Assim, o tumor torna-se de fenótipo vascular e, a 

partir da vascularização tumoral, recebe oxigênio e nutrientes para crescer e 

metastizar (Carmeliet, 2005). 

A vascularização tumoral também contribui para este ciclo, uma vez 

que a desorganização da arquitetura vascular do tumor, pode levar a áreas de 

hipóxia, o que estimula a liberação de VEGF e perpetua a desorganização 

vascular (Carmeliet, 2005). 

De acordo com Nagy et al. (2009), os tumores são “feridas que não 

cicatrizam”, pois em tecidos lesionados normais, o VEGF-A reduz sua 

expressão conforme a hipóxia diminui, resultado da angiogênese, que supre 

estas regiões de hipóxia. Nos tumores existe a expressão exagerada de 

VEGF-A uma vez que esta é induzida não só pela hipóxia, mas também pela 

oncogênese, pela perda de genes supressores tumorais, por hormônios, 

dentre outros fatores (Nagy et al., 2009). 
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Vale ressaltar que o HIF-1α estimula a liberação de citocinas e de 

proteínas como a lisil oxidase (LOX); esta, por sua vez, tem um papel 

relevante no processo de metástase em câncer de mama do tipo ER- e 

também é um mediador importante para a metástase óssea a partir da 

ativação de osteoclastos formando um nicho pré-metastático, com um 

microambiente favorável para a angiogênese e metástase (Sflomos e Brisken, 

2017). Sendo assim, o HIF-1α não está limitado apenas ao crescimento 

tumoral local. 

 

2.1.6 Células 4T1 

 

Fred Miller e colaboradores isolaram as células 4T1 de um câncer de 

mama espontâneo de um camundongo Balb/cfC3H no Karmanos Cancer 

Institute, sendo estas, uma de quatro subpopulações do tumor 410.4 (Pulaski 

e Ostrand-Rosenberg, 2001; DuPré et al., 2007; Tao et al., 2008; Yoshimura 

et al., 2013). 

Estas células apresentam vantagens no seu uso para pesquisa, uma 

vez que têm grande potencial para o surgimento de metástases, que se 

localizam em diversas regiões, como linfonodos, sangue, cérebro, osso, 

pulmões e fígado, sendo que estes dois últimos ocorrem oito dias pós-

inoculação. (Pulaski e Ostrand-Rosenberg, 2001; DuPré et al., 2007; Tao et 

al., 2008; Yoshimura et al., 2013).  

Outra vantagem do carcinoma 4T1 é que este possui características 

semelhantes às do estágio avançado do câncer de mama em humanos, uma 

vez que pode gerar metástases nos mesmos sítios que o câncer de mama em 

humanos e há o surgimento de hipercalcemia. Assim este modelo 

experimental é comumente utilizado uma vez que sua progressão é 

semelhante ao quadro clínico em humanos (Li et al., 2014; Sayers et al., 2014; 

de Almeida et al., 2019). 
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O carcinoma 4T1 é um câncer singênico imunocompetente triplo 

negativo (déficit na epressão de receptores de estrógeno, progesterona e fator 

de crescimento epidérmico humano 2) com alto poder de metastização 

(Steenbrugge et al., 2019; Malekian et al., 2020). Diversos pesquisadores têm 

estudado o modelo experimental do carcinoma 4T1 a fim de entender seu 

microambiente e suas interações com diferentes substâncias para aperfeiçoá-

lo (DuPré et al., 2007; de Almeida et al., 2019; Atiya et al., 2019; Avila et al., 

2019).  

Pesquisas recentes mostram os efeitos do Bisfenol A na resposta 

imune humoral do carcinoma 4T1 (Avila et al., 2019); a influência do RGD na 

capacidade de aderência das células 4T1 na MEC (Mohamedi et al., 2019); a 

inibição da proliferação, migração e invação celular do carcinoma 4T1 a partir 

do uso da Taxifolina (Li et al., 2019) e da inibição da proliferação celular e 

metástase do carcinoma 4T1 a partir de nano reguladores (Zhang et al., 2019). 

 

2.2 Estimulação Elétrica Nervosa Transcutânea (TENS) 

 

A TENS consiste na aplicação de eletrodos (geralmente auto-adesivos) 

sobre a superfície intacta da pele, emitindo uma estimulação elétrica pulsada, 

que atravessa o tecido tegumentar, o que estimula nervos periféricos 

(Johnson et al., 2015; Gibson et al., 2017). Inicialmente foi utilizada para o 

controle de condições dolorosas agudas e crônicas, porém, esta tem sido 

usada para o manejo de outras condições como a neuropatia periférica 

(Gibson et al., 2017). 

A intensidade, duração e frequência da TENS podem ser modificadas. 

A TENS usualmente é dividida em TENS de baixa frequência e TENS de alta 

frequência, sendo que a primeira consiste em uma aplicação de 10 Hz ou 

menos e a última em uma aplicação de 50 Hz ou mais (Gibson et al., 2017). 

A TENS de baixa frequência é comumente aplicada com intensidades 

altas, ou seja, geram contrações musculares; enquanto a TENS de alta 
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frequência é usualmente utilizada com intensidades mais baixas (Gibson et 

al., 2017). 

 

2.2.1 Efeitos da TENS na reparação tecidual 

 

Estudos em modelo animal têm mostrado efeitos positivos da TENS na 

modulação da reparação tecidual, a partir da averiguação da redução de área 

de necrose em retalhos cutâneos (Liebano et al., 2003; 2006; 2008) e da 

estimulação da angiogênese em feridas excisionais (Koca Kutlu et al., 2013; 

Machado et al., 2016; 2017). 

Liebano et al. (2006) e Liebano et al. (2008), submeteram ratos à TENS 

com 5; 10; 15 e 20 mA de intensidade para posteriormente avaliarem a área 

de necrose e a viabilidade do retalho cutâneo. Foi utilizada uma frequência de 

80 Hz (Liebano et al., 2006) e de 2 Hz (Liebano et al., 2008). Os resultados 

destes estudos indicam que apenas o grupo de 15 mA, no qual eram 

evidenciadas leves contrações musculares, apresentou uma menor área de 

necrose quando comparado aos demais grupos (Liebano et al., 2006; 2008).  

Importante destacar que nos estudos de Liebano et al. (2003; 2006; 

2008) não são todos os grupos tratados que apresentam redução da área de 

necrose; e, de acordo com os resultados do trabalho de Folha et al. (2015), a 

TENS burst, aplicada por 30 minutos, ao longo de seis dias, com frequência 

portadora de 100 Hz, frequência de burst de 2 Hz, duração de pulso de 200 

µs e intensidade de 90% do limiar motor inibiu a produção de colágeno tipo I 

e tipo III, mostrou um mau alinhamento de fibras colágenas e ainda não 

apresentou efeitos na vascularização e quantidade de mastócitos em lesão 

tendínea em modelo animal, embora outros estudos tenham observado 

resultados divergentes da aplicação da TENS para esta lesão (Folha et al., 

2015).  

Koca Kutlu et al. (2013) avaliaram os efeitos da TENS e de 

medicamentos de uso tópico na reparação tecidual de feridas incisionais em 
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modelo animal. Seus resultados mostram que a TENS com frequência de 2 

Hz, aplicada por 15 minutos, promoveu aumento da expressão do fator de 

crescimento de fibroblastos (FGF-2), PDGF-A e EGF quando comparada com 

o grupo lesionado não tratado. Também houve maior retração da ferida no 

grupo de TENS em relação aos demais. 

Do Carmo Almeida et al. (2018) realizaram uma revisão sistemática 

com meta-análise com o objetivo de analisar os efeitos da TENS nos níveis 

de citocinas pró-inflamatórias no sangue de adultos e de avaliar como a 

parametrização da TENS afetaria este desfecho. Os autores incluíram seis 

estudos e, na avaliação de risco de viés para avaliação de ensaios clínicos da 

Cochrane Manual of Systematic Reviews nenhum dos estudos apresentou 

risco de viés alto.  

De todos os trabalhos abordados por Do Carmo Almeida et al. (2018), 

apenas o estudo de Ngai et al. (2010) não mostrou diferenças nos níveis de 

IL-8 e TNF-α, os demais trabalhos apontaram diminuição dos níveis de IL-1; 

IL-6 e TNF-α quando comparados aos respectivos grupos controle. Importante 

destacar que as reduções destes marcadores ocorreram tanto em pacientes 

pós-cirúrgicos quanto em portadores de doenças crônicas. 

Os estudos inseridos por Do Carmo Almeida et al. (2018) mostram uma 

parametrização incompleta da TENS. Apenas Ngai et al. (2010) e Fiorelli et 

al. (2012) reportaram a frequência e duração de pulso da TENS, sendo estas 

de 80 Hz, 250 µs com intensidade “forte, porém confortável” (Fiorelli et al., 

2012) e de 2 Hz, 200 µs com intensidade não reportada (Ngai et al., 2010). 

Estes resultados divergentes entre Ngai et al. (2010) e Fiorelli et al. 

(2012) podem indicar efeitos diferentes da TENS sobre citocinas pró-

inflamatórias quando utilizada com modalidades distintas; onde a TENS 

convencional promoveu diminuição e a TENS acupuntura não alterou os 

níveis destas (Do Carmo Almeida et al., 2018).  

Estas diferenças devem ser analisadas com cautela. Do Carmo 

Almeida et al. (2018) discutem que um possível mecanismo de ação da TENS, 

que poderia ter gerado esta queda nos níveis de citocinas pró-inflamatórias, 
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seria a ativação do Sistema Nervoso Autônomo Parasimpático (SNAP); mas 

vale destacar que a maioria dos trabalhos que avaliaram os efeitos da TENS 

nas citocinas pró-inflamatórias utilizaram agulhas como condutor, exceto 

Fiorelli et al. (2012) que foram os únicos autores que usaram eletrodos (Do 

Carmo Almeida et al., 2018) e, estudos sugerem que o uso de técnicas que 

utilizam agulhas, como acupuntura (Li et al., 2013) e agulhamento seco 

(Sillevis et al., 2019), podem causar alterações no Sistema Nervoso Autônomo 

(SNA).  

 

2.2.2 Efeitos vasculares e parametrização 

 

Diversos autores evidenciaram efeitos fisiológicos da TENS, tais como 

diferenças na temperatura tecidual local e distal (Owens et al., 1979; Abram 

et al., 1980; Casale, 1985; Indergrand e Morgan, 1994; Scudds et al., 1995) e 

no fluxo sanguíneo em humanos saudáveis (Casale, 1985; Indergrand e 

Morgan, 1994; Cramp et al., 2000; 2002; Sherry et al., 2001; Sandberg et al., 

2007).  

 

2.2.2.1 Influência no fluxo sanguíneo e temperatura 

 

Os trabalhos de Owens et al. (1979) e Abram et al. (1980) mostraram 

que a TENS aumentou a temperatura tecidual do tecido tegumentar em 

humanos em ensaios clínicos não controlados. Owens et al. (1979) não 

relataram a intensidade e realizaram a aplicação em nervo ulnar, enquanto a 

intensidade utilizada por Abram et al. (1980) foi motora em ponto doloroso. 

Casale (1985), Indergrand e Morgan (1994) e Sccuds et al. (1995) 

observaram diminuição da temperatura em indivíduos saudáveis após 

aplicação de TENS, sendo que no grupo de baixa frequência de Sccuds et al. 

(1995), esta queda foi menor. Casale (1985) evidenciou queda do fluxo 
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sanguíneo enquanto Indergrand e Morgan (1994) relataram que não houve 

alteração do fluxo sanguíneo distal. 

Cramp et al. (2000) e Cramp et al. (2002) realizaram ensaios clínicos 

controlados que avaliaram os efeitos da TENS, na temperatura tecidual e no 

fluxo sanguíneo, em voluntários saudáveis, quando aplicada sobre o nervo 

mediano. Ao comparar diferentes frequências portadoras, foi evidenciado que 

a TENS à 4 Hz promoveu aumento de fluxo sanguíneo (Cramp et al., 2000), 

porém os autores não relataram a intensidade utilizada. Ao comparar 

diferentes intensidades, a TENS promoveu aumento de fluxo sanguíneo 

apenas no grupo de intensidade motora à 4 Hz (Cramp et al., 2002). Não 

houve alteração da temperatura tecidual durante e após a aplicação da TENS 

(Cramp et al., 2000; 2002). 

Sherry et al. (2001) observaram resultados semelhantes aos de Cramp 

et al. (2000) e Cramp et al. (2002), ao aplicar TENS-Burst à 85 Hz sobre os 

nervos tibial e fibular em humanos saudáveis. Apenas a TENS aplicada com 

intensidade 25% acima do limiar motor promoveu aumento de fluxo 

sanguíneo. Não foram evidenciadas alterações de temperatura. 

Sandberg et al. (2007), realizaram a aplicação de TENS de baixa 

frequência (2 Hz) com intensidade motora, TENS de alta frequência (80 Hz) 

com intensidade sensorial e TENS subliminar (menor intensidade que o 

aparelho pode promover sem estímulo sensorial – 0,5 mA). Foi utilizada uma 

duração de pulso de 180 µs e a aplicação foi realizada por 15 minutos. Os 

autores evidenciaram aumento do fluxo sanguíneo (estatisticamente 

significante) nas fibras descendentes do músculo trapézio no grupo de 

intensidade motora, porém não foram observadas alterações de fluxo 

sanguíneo nos demais grupos; e, também não houve aumento de fluxo 

sanguíneo no tecido tegumentar em nenhum dos grupos avaliados. 

 

2.2.2.2 Influência na angiogênese 
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Bevilacqua et al. (2007) aplicou TENS por 10 minutos seguida de um 

intervalo de 30 minutos para, posteriormente ser realizada uma estimulação 

elétrica de frequência modulada (FREMS) na face anterior do antebraço de 

voluntários e, foi evidenciado que a TENS não promoveu aumento do VEGF, 

seja em indivíduos saudáveis como em indivíduos que cursavam com 

diabetes tipo 2.  

As análises para avaliar a expressão de VEGF foram feitas na pré-

aplicação de TENS, no intervalo entre as aplicações de TENS e FREMS e 

após a aplicação de FREMS.  

A FREMS promoveu aumento de VEGF no plasma sanguíneo dos 

voluntários. Os autores não descreveram os parâmetros utilizados para 

TENS, o que implica em um importante viés; uma vez que, de acordo com 

Liebano e Machado (2014), a expressão de VEGF, a partir da aplicação de 

correntes elétricas terapêuticas deve ser parâmetro-dependente. 

Machado et al. (2016) e Machado et al. (2017) aplicaram TENS com 5 

e 80 Hz de frequência, com duração de pulso de 200 µs, intensidade de 15 

mA (motora), por 60 minutos em ratos submetidos a feridas excisionais 

agudas, durante três dias. Embora as análises utilizadas nos estudos tenham 

sido diferentes, o objetivo destas era o mesmo, ver os efeitos da TENS na 

reparação tecidual a partir de desfechos relacionados à angiogênese. 

Machado et al. (2016) mostraram que a TENS de 80 Hz inibiu a 

angiogênese e a produção de miofibroblastos, enquanto a TENS de 5 Hz 

estimulou a angiogênese; porém, no trabalho de Machado et al. (2017), a 

TENS promoveu a angiogênese em ambos os grupos. 

 

2.2.3 Mecanismos de ação relacionados à vascularização 

 

Estudos que avaliam os efeitos da TENS na temperatura tecidual, fluxo 

sanguíneo e reparação tecidual comumente justificam seus resultados a partir 

de diferentes possíveis mecanismos de ação desta sobre a vascularização 
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(Abraam et al., 1976; Owens et al., 1979; Abram et al., 1980; Indergrand e 

Morgan, 1994; Scudds et al., 1995; Sherry et al., 2001; Cramp et al., 2000; 

2002; Liebano et al., 2006; 2007; Machado et al., 2016; 2017). 

 

2.2.3.1 Sistema Nervoso Autônomo (SNA) 

 

Diversos pesquisadores que avaliam os efeitos da TENS sobre fluxo 

sanguíneo e temperatura local justificam seus resultados a partir da inibição 

ou estimulação no SNA (Abraam et al., 1976; Owens et al., 1979; Abram et 

al., 1980; Scudds et al., 1995; Cramp et al., 2000). 

Diferentes autores mostram, em seus resultados, que a 

eletroestimulação não tem influência no sistema nervoso autônomo simpático 

(SNAS) a partir da avaliação indireta deste, ou seja, da conductibilidade e 

temperatura da pele, do tamanho das pupilas, da frequência cardíaca e da 

pressão arterial (Ebersold et al., 1977; Reeves et al., 2004). 

Por outro lado, Okuyucu et al. (2017) aplicaram a TENS na mão de 

voluntários saudáveis e avaliaram a resposta sudomotora destes. Seus 

resultados indicam que a TENS inibiou o SNAS a partir da diminuição da 

resposta sudomotora. A aplicação da TENS não é bem descrita neste estudo, 

os autores relatam utilizar frequência alta e baixa, porém não dizem qual sua 

taxa de repetição. Os autores também não dão maiores informações sobre as 

características físicas da corrente utilizada.  

Os resultados de Okuyucu et al. (2017) podem não representar uma 

inibição do SNAS ou estimulação do SNAP, uma vez que os autores apenas 

avaliaram a resposta sudomotra e esta pode ser deflagrada a partir do reflexo 

axonal (Yaprak, 2008). O SNAS pode ter um papel importante no fluxo 

sanguíneo, onde sua inibição acarreta em um aumento do fluxo sanguíneo a 

partir de vasodilatação cutânea (Cramp et al., 2000). 

 

2.2.3.2 Reflexo axonal 



R e v i s ã o  d a  L i t e r a t u r a  | 31 

 

 

O trabalho de Khalil et al. (2001) evidenciou que a TENS de frequência 

15 Hz propiciou liberação de substância P (SP); e, quando aplicada com 5 Hz 

de frequência promoveu a liberação de peptídeo relacionado ao gene 

calcitonina (CGRP) em aplicação no nervo isquiático. 

A TENS promove uma estimulação antidrômica a partir da estimulação 

de fibras nervosas A-δ e C, o que acarreta na liberação de neuropeptídeos 

como o CGRP, SP e o polipeptídeo intestinal vasoativo (VIP); sendo estes 

vasodilatadores potentes e, por conta disto, têm sido relacionados a um 

aumento do fluxo sanguíneo local e consequente promoção da reparação 

tecidual (Liebano et al., 2006; 2008; Machado et al., 2016). 

Este mecanismo de ação da TENS na reparação tecidual é o mais bem 

aceito por pesquisadores (Machado et al., 2016), sendo que diversos autores 

justificam o aumento de fluxo sanguíneo (Scudds et al., 1995) e a modulação 

da reparação tecidual tegumentar a partir do reflexo axonal (Liebano et al., 

2006; 2008; Machado et al., 2016; 2017).  

 

2.2.3.3 Bomba muscular 

 

O mecanismo de bomba muscular ocorre a partir do acúmulo de 

substâncias vasodilatadoras locais e da vasodilatação induzida por fatores 

relaxantes advindos do endotélio; e, assim, acarreta no aumento do fluxo 

sanguíneo (Sherry et al., 2001).  

 Diversos autores mencionam este mecanismo para justificar o 

aumento de fluxo sanguíneo local em humanos submetidos à TENS em 

intensidade motora e, em sua maioria, com frequência baixa (Scudds et al., 

1995; Sherry et al., 2001; Cramp et al., 2002). Cramp et al. (2002) também 

teorizam que o aumento de fluxo sanguíneo pode ocorrer pela maior demanda 

metabólica muscular no grupo de intensidade motora.  
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Assim como a contração muscular pode acarretar em um aumento de 

fluxo sanguíneo, segundo Scudds et al. (1995), a ausência ou diminuição 

desta pode contribuir para a queda de temperatura de voluntários submetidos 

à TENS em repouso.  

 

2.2.4 Efeito de correntes elétricas terapêuticas no metabolismo 

 

Os efeitos da TENS no metabolismo local não são estudados de forma 

direta. De acordo com a lei de Van’t Hoff um aumento de 4°C da temperatura 

tecidual está associado a um aumento de 50% do metabolismo (Robertson et 

al., 2009), mas a TENS é um recurso que provê uma corrente elétrica de 

intensidade em miliamperes (mA) (Robertson et al., 2009), não sendo uma 

fonte primária de calor. 

Estudos que avaliaram os efeitos da TENS sobre a temperatura local 

trazem resultados divergentes como visto anteriormente (Owens et al., 1979; 

Abram et al., 1980; Scudds et al., 1995; Sherry et al., 2001; Cramp et al., 2000; 

2002), ainda que os mais recentes mostrem que não haja aumento desta 

(Cramp et al., 2000; 2002). 

 

2.2.5 Efeitos das correntes bifásicas em tumores 

 

No estudo de Linkov et al. (2012) foi realizada uma estimulação elétrica 

de 80 Hz, com duração de pulso de 700 µs, por 30 minutos de aplicação, à 

uma intensidade motora sobre o carcinoma espinocelular, advindo da 

inoculação de 107 células SCC7, na lateral do tronco de camundongas C3H 

nudes (n=7), por oito dias não consecutivos. Não foram evidenciadas 

diferenças nas análises de crescimento tumoral, vascularização, proliferação 

e apoptose, entre o grupo ativo e o grupo controle.  
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Wang et al. (2018) aplicaram TENS sobre em câncer cervical (SiHa) 

em camundongos Balb/c nudes com uma frequência de 1/4/1 Hz, duração de 

pulso de 230/270/230 µs, por 20 minutos, uma única vez. A intensidade 

utilizada foi de 20 mA de forma fixa, os autores não relataram se esta gerou 

contrações musculares ou não. Os resultados de Wang et al. (2018) 

mostraram que não houve diferença estatisticamente significante entre o 

grupo controle e o grupo ativo para o crescimento tumoral, apoptose, 

proliferação e angiogênese. 

 

2.2.6 Aplicações na Fisioterapia Oncológica 

 

A revisão sistemática de Hurlow et al. (2015) mostra, em seus 

resultados, que a TENS pode ser um bom recurso para a diminuição da dor 

oncológica óssea; porém os autores incluíram apenas três estudos nesta 

revisão e, sendo assim, apontam para esta possibilidade terapêutica, mas os 

resultados são inconclusivos. 

Amaral et al. (2019) também realizaram uma revisão sistemática, um 

pouco mais abrangente, a fim de averiguar os efeitos da TENS na dor 

oncológica; porém, obtiveram apenas quatro estudos e, portanto, os 

resultados também são inconclusivos. 

Erden et al. (2022), em seu ensaio clínico, utilizaram TENS em 

pacientes pós-mastectomia radical modificada e foram obtidos resultados 

significantes na diminuição da dor destes quando associada ao sono, 

mobilização e ansiedade. 

Püsküllüoğlu et al. (2022) apontam que a TENS pode ser um recurso 

seguro e de auto-manejo para pacientes oncológicos; porém, por hora, não 

há evidência forte o suficiente que suporte o uso desta para o manejo de 

sintomas de neuropatia periférica induzida por quimioterapia. 

Fanan et al. (2022), em uma revisão integrativa da literatura 

encontraram apenas quatro estudos sobre uso da TENS em pacientes 
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oncológicos em cuidados paliativos. Os autores destacam os efeitos benéficos 

que a TENS pode promover, como a redução do quadro álgico e a diminuição 

do uso de drogas analgésicas nesta população, porém destacam a 

necessidade de futuros estudos. 

 

2.3 Histologia e imunohistoquímica  

 

A coloração histológica é um procedimento comum para a realização 

de estudos forenses e diagnósticos. O processo de coloração histológica é 

composto por cinco estágios fundamentais, sendo estes a fixação, 

processamento, embebição, secção e coloração (Alturkistani et al., 2016). 

A imunohistoquímica permite a observação de proteínas relacionadas 

a tecidos patológicos ou não a partir de reações específicas entre anticorpos 

e antígenos, posteriormente estes tecidos podem ser visualizados na análise 

de microscopia a partir de diferentes cores ou flurescência (Wang et al., 2008). 

 

2.3.1 Coloração por Hematoxilina e Eosina (HE) 

 

A coloração por Hematoxilina e Eosina (HE) é a mais utilizada em todo 

o mundo; atualmente, quase todos os tipos de tecidos biológicos são corados 

com HE. A coloração de HE é vantajosa, uma vez que é de rápida execução 

e não é custosa. Esta coloração provê uma imagem morfológica excelente 

para a visualização dos núcleos celulares e do citoplasma (Alwahaibi et al., 

2012; Alturkistani et al., 2016).  

A hematoxilina é tida como o corante mais importante utilizado na 

histologia, histopatologia e citologia. É usada para a visualização de núcleos 

(pigmentados de azul), ácidos nucleicos, fibras do tecido conjuntivo e 

componentes intracelulares, como mitocôndrias, cromatina, nucléolos, 
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centríolos e também em imunohistoquímica (Alwahaibi et al., 2012; 

Alturkistani et al., 2016; Mohandas et al., 2019). 

A eosina é um corante sintético, formado pela reação entre o bromo e 

a fluoresceína. Ela é ácida e tem afinidade com o grupo β-amino da lisina e o 

grupo guanidina da arginina. Como a maior parte das proteínas possuem os 

dois aminoácidos supracitados, a eosina pode pigmentar a maior parte das 

estruturas teciduais, porém, isto não ocorre com o glicogênio e proteoglicanos 

da MEC e grânulos de mastócitos. (Mohandas et al., 2019). 

 

2.3.2 Imunohistoquímica indireta por CD31 

 

Existem diversos marcadores imunohistoquímicos para a identificação 

de células endoteliais, sendo o marcador CD31, ou molécula de adesão 

plaqueta-célula endotelial-1 (PECAM-1), um dos mais comumente utilizados 

para a análise do endotélio vascular (Wang et al., 2008; Pazzini et al., 2017).  

O CD31 é encontrado em grandes quantidades na superfície de células 

endoteliais e é menos presente em plaquetas e leucócitos. Ele possui um 

papel importante em diferentes interações celulares, principalmente na 

adesão entre células endoteliais e leucócitos polimorfonucleares, monócitos e 

linfócitos durante a inflamação; e, entre células endoteliais durante a 

angiogênese (Wang et al., 2008). 

A coloração imunohistoquímica de microvasos para a avaliação da 

densidade vascular é associada ao grau de neovascularização intratumoral, 

potencial metastático e prognóstico de diferentes tumores sólidos em 

humanos (Wang et al., 2008). Portanto, a imuno-histoquímica, para a 

detecção de CD31, tem sido muito utilizada para a quantificação da 

angiogênese tumoral em modelos animais (Wang et al., 2008).  

 

2.3.3 Impregnação argêntica para reticulina 
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As fibras reticulares ou fibras argirofílicas, formam uma rede extensa 

em alguns órgãos. Estas fibras não são visualizadas em microscopia de luz 

quando coradas em HE; para que estas sejam visualizadas é necessário que 

seja realizada a impregnação argêntica, e assim as fibras reticulares são 

coradas de preto (Ushuki, 2002).  

As fibras reticulares formam uma rede delicada de fibras finas, 

presentes em poucas localizações, sendo subjacentes à lâmina basal de 

células epiteliais, na superfície de adipócitos, miócitos, células de Schwann e 

no retículo fibroso de tecidos linfáticos (Ushuki, 2002).  

Estudos mostram que as fibras reticulares, diferentemente das fibras 

colágenas, são compostas por colágeno tipo III em associação com outros 

tipos de colágeno (como o colágeno tipo V), glicoproteínas e proteoglicanos. 

O arranjo reticular das fibrilas promove espaço para movimentos moleculares 

no fluído extracelular, para os tecidos linfáticos; este arranjo fornece uma 

estrutura de suporte (esquelético) para vasos e linfonodos (Ushuki, 2002). 

O uso da impregnação argêntica para reticulina é importante dentro da 

oncologia em diagnósticos diferenciais uma vez que os tecidos tumorais 

apresentam uma estrutura diferente de tecidos não patológicos (Lucero et al., 

2016; Torres et al., 2016). 

O trabalho de Shehata et al. (2004) evidenciou que o TGF-β1 

desempenha um importante papel na indução da fibrose por deposição de 

fibras de reticulina na leucemia de células pilosas, sendo este um importante 

indicador de progressão tumoral. 
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3.0 OBJETIVOS 

 

3.1 Objetivo geral 

 

O objetivo deste estudo foi avaliar os efeitos da aplicação da TENS de 

alta e baixa frequência no carcinoma 4T1. 

 

3.2 Objetivos específicos 

 

Avaliar os efeitos da aplicação da TENS de alta e baixa frequência na 

angiogênese do carcinoma 4T1, por meio da avaliação de imunohistoquímica 

com o anticorpo CD31. 

Avaliar os efeitos da aplicação da TENS de alta e baixa frequência na 

proliferação celular do carcinoma 4T1, por meio da avaliação histológica com 

lâminas coradas com Hematoxilina e Eosina. 

Avaliar os efeitos da aplicação da TENS de alta e baixa frequência na 

área de fibras de reticulina carcinoma 4T1, por meio da avaliação de lâminas 

de reticulina. 
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4.0 MÉTODOS 

 

4.1 Aspectos Éticos 

 

Esta pesquisa foi aprovada pela Comissão de Ética no Uso de Animais 

(CEUA) da Faculdade de Medicina da Universidade de São Paulo (FMUSP) 

(nº 040/15; 25/03/2015) (Anexos 1; 2 e 3). Os animais são provenientes do 

Biotério Central da FMUSP, em São Paulo; os procedimentos realizados estão 

de acordo com as normas éticas para experimentação animal do Conselho de 

Organizações Internacionais de Ciências Médicas (CIOMS), as normas da 

Sociedade Brasileira de Ciência de Animais de Laboratório (SBCAL – 

COBEA) e a legislação nacional atual sobre procedimentos para uso científico 

de animais (Lei Federal 11.794, de 9 de outubro de 2008).  

 

4.2 Desenho de estudo 

 

O presente trabalho é um estudo pré-clínico em modelo animal, 

controlado e aleatorizado. O estudo segue a ferramenta de avaliação de risco 

de viés para estudos em modelo animal SYRCLE (Hooijmans et al., 2014), 

sendo esta recomendada por Ma et al. (2020). 

 

4.3 Animais 

 

Foram utilizados 30 camundongos da linhagem Balb/c, fêmeas com 7 

a 9 semanas de idade, em que já há influência dos hormônios sexuais (Chorilli 

et al., 2007) com 15 a 25 g de massa. Os animais foram divididos em três 

grupos (n=10) e ficaram em caixas com cinco animais cada. As caixas foram 

alocadas na mesma prateleira do mesmo quarto, uma ao lado da outra, no 

Centro de Medicina Nuclear da FMUSP em ambiente controlado a 20ºC +/- 
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2ºC, ciclo claro/escuro de 12 horas com ração e água ad libitum. O 

refinamento ambiental se deu a partir da socialização harmônica entre os 

animais dentro de uma mesma caixa e o uso de rolos de papel higiênico 

(Baumans e Van Loo, 2013). 

O cálculo amostral foi realizado a partir do trabalho de Eckelman et al. 

(2007) e Arifin e Zahiruddin (2017). A aleatorização foi feita em cluster via 

www.random.org. Os experimentos in vitro e in vivo foram realizados no 

Centro de Medicina Nuclear da FMUSP. 

 

4.4 Experimento in vitro: Cultura de células 4T1 

 

As células de câncer de mama murino 4T1 foram cultivadas em meio 

Roswell Park Memorial Institute (RPMI) (Gibco, BRL), com pH 7,2, 

suplementado com 10% de soro fetal bovino (Gibco, BRL) e antibióticos 

estreptomicina e ampicilina (100 μg/mL, Sigma) (Yang et al., 2013), em 

atmosfera úmida contendo 5% CO2 a 37ºC.  Ao atingirem de 80% a 90% de 

confluência celular, as células foram lavadas com uma solução de tampão de 

fosfato salino com ácido etilenodiamino tetra-acético (PBS/EDTA) com pH 7,2, 

destacadas das garrafas de cultura celular com solução de tripsina 0,2% 

(Sigma) (Yang et al., 2013) e transferidas para novas garrafas. 

 

4.5 Experimento in vivo: Inoculação das células 4T1 e análise do 

crescimento tumoral 

 

As células tumorais foram inoculadas com 50 µL de uma suspensão 

contendo 5x104 células 4T1 em meio RPMI, sem soro, subcutaneamente, na 

glândula mamária intermédia esquerda. Todos os grupos foram observados 

diariamente para verificação do aparecimento de massa tumoral. A técnica 

responsável/cuidadora era cega em relação ao tratamento dado aos animais. 
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4.6 Procedimentos experimentais 

 

O tratamento com a TENS iniciou-se 12 dias após a inoculação das 

células, com aparecimento de tumor palpável (Linkov et al., 2012), a fim de 

tratar tumores com um volume superior a 3 mm³, já vascularizados (Hoeben 

et al., 2004). Os animais foram tratados por 10 sessões de TENS, com uma 

sessão de 20 minutos por dia, com intervalo de 2 dias entre a quinta e a sexta 

sessão (Linkov et al., 2012), a fim de reproduzir a prática clínica (Farcic et al., 

2018) (Figura 1). 

 

 

Figura 1. Fluxograma do protocolo de estudo. Legenda: GA - Grupo de alta frequência; GB - Grupo de 

baixa frequência; GS - Grupo sham; tto - Tratamento. 
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A realização da TENS foi efetuada sempre pelo mesmo pesquisador e 

durante o mesmo período do dia. Animais que apresentaram ruptura 

importante da epiderme ao longo do experimento não receberam o 

tratamento, a fim de realizar a estimulação elétrica apenas de fibras Aβ em 

todos os animais, uma vez que lesões na epiderme podem alterar a 

impedância desta e a passagem da corrente em tecido lesionado pode 

estimular fibras Aδ antes de estimular as fibras nervosas Aα (Liebano et al., 

2006; Robertson et al., 2009). 

Foi realizada uma TENS convencional de pulso bifásico e simétrico por 

meio do equipamento Fes VIF, modelo 995-4, número de série 07x150, da 

QUARK® produtos médicos Indústria Brasileira, previamente calibrado (Figura 

2). 

 

 

Figura 2. Estimulação elétrica enquanto os animais permanecem anestesiados com isofurano a 1,5%. 
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Foram contruídos eletrodos de borracha siliconada carbonada de 1 cm² 

de área de superfície para a eletroestimulação dos animais a partir de 

eletrodos da QUARK® (Figura 3).  

 

 

Figura 3. Eletrodo de silicone carbonado com 1 cm² de área de superfície. 

 

Os eletrodos foram acoplados com gel hidrossolúvel e fixados com fita 

curativa hipoalergênica Micropore® (Nextcare – 3M) sob o tumor e 

imediatamente ao lado deste, na região abdominal (Figura 4).  
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Figura 4. Fixação dos eletrodos com fita curativa hipoalergênica em região abdominal. 

 

4.7 Protocolo experimental: Grupos de tratamento 

 

Para realizar uma estimulação com intensidade sensorial máxima foi 

realizado um experimento prévio no qual quatro animais foram 

eletroestimulados na região abdominal até que fossem evidenciadas 

contrações musculares. Os parâmetros utilizados foram de 100 Hz de 

frequência portadora e 200 µs de duração de pulso. Dos animais 

eletroestimulados, três apresentaram contração muscular com 4 mA, sendo 

estabelecido que a intensidade sensorial inicial máxima seria de 3,0 mA. 

Para que não houvesse o fenômeno de acomodação sensorial, foi 

realizado um acrécimo de 1,0 mA a cada cinco minutos; porém, caso fosse 

evidenciada contração muscular após este, manter-se-ia a intensidade prévia. 
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Os grupos de animais foram tratados em ordem aleatória. Todos os 

animais foram anestesiados com isoflurano a 1,5% durante a aplicação da 

TENS, por 20 minutos na câmara IVIS® Spectrum. Os animais foram divididos 

e tratados com os seguintes parâmetros:  

• Grupo de Alta Frequência (GA): Foi tratado com frequência de 100 Hz, 

duração de pulso de 200 µs e intensidade sensorial inicial de 3,0 mA.  

• Grupo de Baixa Frequência (GB): Foi tratado com frequência de 10 Hz, 

duração de pulso de 200 µs e intensidade sensorial inicial de 3,0 mA. 

• Grupo Sham (GS): Os animais foram submetidos aos mesmos 

procedimentos que os grupos supracitados, incluindo a inalação de 

isoflurano e fixação de eletrodos ao longo de 20 minutos, porém, os cabos 

do aparelho de TENS permaneceram desconectados. 

Os animais foram tratados com diferentes frequências portadoras 

baseadas nos diferentes resultados de estudos prévios ao se utilizar 

frequências baixas e altas de TENS (Cramp et al., 2000; Liebano et al., 2008). 

 

4.8 Eutanásia e armazenamento de material biológico 

 

Todos os animais foram mortos após o décimo dia de tratamento com 

quetamina + xilazina (100 mg/Kg + 10 mg/Kg) (Lapchik et al., 2010) seguido 

de permanência em câmara de CO2 (Linkov et al., 2012; Farcic et al., 2018) 

no mesmo período do dia. Os tumores foram extirpados e imersos em formol 

tamponado (3,7% em PBS) por pelo menos 18 horas; a seguir foi realizada 

lavagem com água destilada, uma vez por minuto, em temperatura ambiente, 

para a remoção total do formol; e, o material foi mantido em etanol 70% até o 

preparo dos cortes, em região central do tumor, para análise histológica. 

 

4.9 Imunohistoquímica indireta para CD31 
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Foi utilizado o anticorpo monoclonal da Cell Signaling Technology®: 

anti-CD31 (PECAM-1; clone D8V9 XP®, cell signal #77699) que reconhece a 

proteína PECAM-1 expressa por células endoteliais.  

Para a reação, os cortes histológicos foram desparafinados com xilol e 

hidratados usando concentrações graduadas de etanol à água destilada. Na 

recuperação antigênica pelo calor, as lâminas histológicas foram mergulhadas 

no tampão Tris buffer (0,5 M, pH 10) e levadas a um forno microondas por 15 

minutos, em potência de 80%.  

Seguindo bloqueio da atividade da peroxidase endógena (3% 

H2O2:metanol) e pré-incubação com soro normal de cabra a 10%, o anticorpo 

primário (anti-CD31 diluição: 1/20), diluído em 1x TBS/ 1% BSA, foi aplicado 

sobre os cortes por 12 horas a 4°C.  

Após incubação com anticorpo secundário conjugado à peroxidase por 

1 hora a 37°C, a detecção colorimétrica foi realizada por meio do kit 3,3’-

diaminobenzidina-DAB (DAKO, K3468) por 2 minutos em temperatura 

ambiente. A contracoloração foi realizada com hematoxilina de Harris por 1 

minuto; e, a montagem das lâminas, processada com ERV-MOUNT 

(EasyPath, EP-MOUNT 1500). Entre cada etapa, as lâminas foram 

enxaguadas com as soluções de lavagem, 1x TBS/ 0,025% Triton X-100 e 1x 

TBS/ 0,1% Tween-20, por 5 minutos (x2-3, temperatura ambiente). 

Para tal reação, o próprio tecido tumoral foi utilizado como controle 

positivo das marcações, e controle negativo sem incubação com os anticorpos 

primários. Foram realizados cortes histológicos tumorais centrais para cada 

lâmina submetida à reação imunohistoquímica. 

Foi montada uma lâmina histológica por animal. O material foi 

observado em microscópio de luz com aumento total de 20 vezes, as imagens 

foram adquiridas utilizando o microscópio EVOS® FL Auto Imaging System no 

Instituto do Câncer do Estado de São Paulo (ICESP). 

 

4.10 Impregnação argêntica para reticulina 
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A marcação histoquímica para demonstrar fibras reticulares 

argirofílicas foi realizada por meio de kit, seguindo metodologia padronizada 

(Kit EasyPath, Reticulina; Erviegas, cód. EP-12- 20021). As fibras reticulares 

foram visualizadas em negro por microscopia de luz com aumento total de 20 

vezes; as imagens foram adquiridas utilizando o microscópio EVOS® FL Auto 

Imaging System no Instituto do Câncer do Estado de São Paulo (ICESP). 

Foram tiradas cinco fotos aleatórias da área de tecido viável das 

lâminas de HE incubadas com CD31, lâminas de HE e lâminas de reticulina. 

Foi calculada a área de vasos sanguíneos, dos núcleos celulares e das fibras 

de reticulina.  

 

4.11 Pré-processamento, processamento e análise de imagens 

 

As imagens foram analisadas no software ImageJ 2.9.0/1.53t. Foi 

realizado o pré-processamento destas a partir do melhoramento de imagem; 

seguido do processamento por segmentação; e, por fim a análise destas por 

meio da área fracionada (Anexo 4). O protocolo utilizado foi baseado no 

trabalho de Nichelle et al. (2020). 

 

4.12 Análise estatística 

 

Foi utilizado o programa Jamovi 2.3.21 com um poder de 80%, nível de 

significância de 5% e intervalo de confiança de 95%. Foi realizado o teste de 

Shapiro-Wilk para avaliar a distribuição dos dados dos grupos; para verificar 

se há diferenças entre os grupos foi aplicado o teste de Kruskal-Wallis, para 

dados de distribuição não-normal, e, para dados de distribuição normal, foi 

utilizado o teste One-Way ANOVA (Gosselin, 2019). Para calcular o tamanho 

de efeito foi utilizado o Epsilon-squared (ε²), quando performado o teste 
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Kruskal-Wallis, e diferença das médias F, para o teste One-Way ANOVA. Os 

gráficos utilizados foram feitos a partir da recomendação de In e Lee (2017). 
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5.0 RESULTADOS 

 

Todas as lâminas referentes aos 22 animais (após aplicados os 

critérios de exclusão) foram utilizadas nestas análises.  

 

5.1 Angiogênese 

 

5.1.1 Pré-processamento 

Para se calcular a área de vasos sanguíneos, foi utilizado o pré-

processamento por deconvolução em H&E DAB, sendo selecionado o canal 

3 (Figura 5A). Após isto, foi realizado o melhoramento de imagem, sendo 

ajustado o brilho e contraste de cada imagem individualmente, a fim de se 

obter o maior contraste possível entre o objeto de avaliação e o plano de 

fundo. Para tal, foi colocado o valor mínimo à esquerda do histograma (Figura 

5B), seguido da diminuição do valor máximo, a fim de se excluir o plano de 

fundo; porém, o valor máximo não seria baixo a ponto de esmaecer o objeto 

de estudo (Figura 5C) e, posteriormente, foi aumentado o contraste ao 

máximo, para diminuir a interferência do plano de fundo (Figura 5D). 
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Figura 5. Pré-processamento das imagens de imunohistoquímica. Legenda: A – Deconvolução H&E 
DAB canal 3; B – Ajuste mínimo de brilho; C – Ajuste máximo de brilho; D – Ajuste máximo de contraste. 

 

5.1.2 Processamento 

O processamento das imagens se deu pela segmentação destas por 

auto local threshold. A seleção destes foi baseada na literatura junto à análise 

qualitativa (Figura 6). 
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Figura 6. Análise de auto local thresholds para imunohistoquímica. As áreas em branco correspondem 
ao objeto de análise. 

 

Foi determinado o uso do auto local threshold denominado como Otsu 

(Figura 7A). Foram utilizados os valores padrões do software (radius = 15; 

parameter 1 = 0; parameter 2 = 0). O valor de radius utilizado foi de 15, onde 

ao se comparar o valor 3 com 15, ambos apresentaram resultado semelhante 

(Figuras 7B e 7C). 
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Figura 7. Teste de radius para imunohistoquímica. As áreas em branco correspondem ao objeto de 
análise. Legenda: A – Imagem pré-processada; B – Imagem segmentada com radius = 15; C – Imagem 
segmentada com radius = 3. 

 

5.1.3 Análise 

 A área fracionada dos vasos sanguíneos foi calculada pelo software 

ImageJ. 

O teste Shapiro-Wilk mostrou uma distribuição não-normal em GA 

(p=0,049). O teste de Kruskal-Wallis mostrou que não houve diferenças entre 

os grupos para a área fracionada de vasos sanguíneos (p=0,612; ε²=0,0467) 

(Figuras 8, Gráfico 1). 
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Figura 8. Fração da área de vasos sanguíneos por grupo. Os vasos sanguíneos são evidenciados pela 
coloração amarronzada como o indicado pela seta amarela. As células dentro destes, de aspecto 
translúcido, são as hemácias. Os vasos sanguíneos evidenciados se apresentam colabados. Legenda: 

GA - Grupo de alta frequência; GB - Grupo de baixa frequência; GS - Grupo Sham. 

 

 

Gráfico 1. Fração da área de vasos sanguíneos por grupo. Legenda: GA - Grupo de alta frequência; 

GB - Grupo de baixa frequência; GS - Grupo Sham; ■ – média;  • - outlier.  



R e s u l t a d o s  | 53 

 

 

 

 

5.2 Proliferação celular 

 

5.2.1 Pré-processamento 

Para se calcular a área dos núcleos celulares, bem como a quantidade 

destes, foi utilizado o pré-processamento por melhoramento de imagem, a 

partir do balanço de cores. Foram balanceadas as cores azul e vermelha de 

cada imagem individualmente, a fim de se destacar os núcleos do citoplasma 

e do interstício celular. Foi destacada a metade esquerda do histograma das 

cores supramencionadas (Figura 9). 

 

 

Figura 9. Balanceamento de cores. Legenda: A – Ajuste mínimo do comprimento de onda da cor 
vermelha; B – Ajuste máximo do comprimento de onda da cor vermelha; C – Ajuste mínimo do 
comprimento de onda da cor azul; D – Ajuste máximo do comprimento de onda da cor azul. 
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As etapas a seguir foram realizadas baseadas no trabalho de Nichelle 

et al. (2020). Foi feita a dissociação entre os canais das cores primárias e, 

desta forma, foi selecionando o canal azul (Figura 10A). Para se obter o maior 

contraste possível entre o objeto de avaliação e o plano de fundo foi utilizado 

o melhoramento de contraste automático, com um histograma equalizado e 

saturação de pixels padrão em 0,35% (Figura 10B). Em seguida, foi aplicada 

a função despeckle para a redução de ruído na imagem (Figura 10C).  

 

 

Figura 10. Pré-processamento das imagens de HE. Legenda: A – Canal azul da imagem previamente 
balanceada; B – Melhoramento de contraste; C – Redução de ruído. 

 

5.2.2 Processamento 

O processamento das imagens se deu pela segmentação destas por 

auto local threshold. A seleção destes foi baseada na literatura junto à análise 

qualitativa (Figura 11). 
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Figura 11. Análise de auto local thresholds para imagens de HE. As áreas em branco correspondem ao 

objeto de análise. 

 

Foi determinado o uso do auto local threshold denominado como 

Savoula (Figura 12A). Foram utilizados os valores padrões do software (radius 

= 15; parameter 1 = 0; parameter 2 = 0). O valor de radius foi de 15, onde ao 

se comparar o valor 3 com 15, o último foi mais preciso, como visto em 

Nichelle et al. (2020) (Figura 12B e 12C). 
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Figura 12. Teste de radius para HE. As áreas em branco correspondem ao objeto de análise. Legenda: 
A – Imagem pré-processada; B – Imagem segmentada com radius = 15; C – Imagem segmentada com 
radius = 3. 

 

5.2.3 Análise 

 A área fracionada dos núcleos celulares foi computada pelo software 

ImageJ. 

Para realizar a análise de partículas, foram estabelecidas faixas para 

área e para circularidade de todos os grupos avaliados. Ao estabelecer uma 

caracterização da área e da circularidade das diferentes áreas de necrose e 

de tecido viável, a análise final poderia ser realizada de forma direcionada ao 

tecido viável, uma vez que as células do infiltrado inflamatório têm tamanhos 

e formas diferentes do tecido viável. 

Foram calculadas a área e a circularidade de cinco células da área de 

necrose tecidual dentro do tecido viável e do tecido viável de dois animais por 

grupo, totalizando seis animais (30 células para região). 
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Os valores foram computados no software Jamovi e foi evidenciado 

grande desvio padrão e intersecção dos valores entre cada região, tanto para 

a área dos núcleos quanto para a circularidade destes (Tabela 1).  

 

Tabela 1 – Avaliação de área e circularidade dos núcleos celulares por 
região do tecido neoplásico viável 

Estatística 
descritiva  Região Área (pixel²) Circularidade 

Média Necrose 293 0,718 
  Tecido viável 404 0,775 
Mediana Necrose 241 0,724 
  Tecido viável 376 0,800 

Desvio padrão Necrose 207 0,0974 
  Tecido viável 131 0,0795 
Mínimo Necrose 94 0,477 
  Tecido viável 163 0,598 
Máximo Necrose 967 0,887 
  Tecido viável 771 0,913 

Shapiro-Wilk p Necrose < ,001 0,610 
  Tecido viável 0,366 0,318 
 

 

A partir desses resultados foram realizados testes com 0; 100 e 241 

pixels² de valor mínimo de área com circularidade de 0-1 (Figura 13).  
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Figura 13. Análise de diferentes valores mínimos de área nuclear. Legenda: A – Imagem original de 
lâmina de HE; B – Imagem analisada sem valor mínimo de área de partícula; C – Imagem analisada 
com valor mínimo de área de partícula de 100 pixels²; D - Imagem analisada com valor mínimo de área 
de partícula de 241 pixels². 

 

Após análise qualitativa, foi estabelecido que seria utilizada a faixa de 

100-10.000 pixels² para área e de 0-1 para circularidade. 

O teste Shapiro-Wilk mostrou uma distribuição normal em todos os 

grupos para fração de área de núcleos celulares (p>0,05). O teste de One-

Way ANOVA não evidenciou diferença significante entre os grupos (p=0,152 

e F=2,08) e o teste de Lavene evidenciou homogeneidade das variâncias 

(p=0,176) (Figura 14 e Gráfico 2). 
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Figura 14. Lâminas de Hematoxilina e Eosina. Os núcleos são visualizados com coloração roxa escura 
como o evidenciado pela seta amarela. A análise se deu a partir da área ocupada pelos núcleos em 
relação à imagem completa. Legenda: GA - Grupo de alta frequência; GB - Grupo de baixa frequência; 
GS - Grupo Sham. 
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Gráfico 2. Fração de área de núcleos por grupo para lâminas de HE. Legenda: GA - Grupo de alta 
frequência; GB - Grupo de baixa frequência; GS - Grupo Sham; CI – Intervalo de confiança. 

 

5.3 Fibras de reticulina 

 

5.3.1 Pré-processamento 

Para se calcular a área das fibras de reticulina, foi utilizado o pré-

processamento por deconvolução em Masson Trichrome, sendo selecionado 

o canal 1 (Figura 15A). Após isto, foi realizado o melhoramento de imagem, 

sendo ajustado o brilho e contraste de cada imagem individualmente, a fim de 

se obter o maior contraste possível entre o objeto de avaliação e o plano de 

fundo. Para tal, foi colocado o valor mínimo à esquerda do histograma (Figura 

15B), seguido da diminuição do valor máximo, a fim de se excluir o plano de 

fundo; porém, o valor máximo não seria baixo a ponto de esmaecer o objeto 

de estudo (Figura 15C) e, posteriormente, foi aumentado o contraste ao 

máximo, para diminuir a interferência do plano de fundo (Figura 15D). 
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Figura 15. Pré-processamento das imagens de fibras de reticulina. Legenda: A – Deconvolução Masson 
Trichrome no canal 1; B – Ajuste mínimo de brilho; C – Ajuste máximo de brilho; D – Ajuste máximo de 
contraste. 

 

5.3.2 Processamento 

O processamento das imagens se deu pela segmentação destas por 

auto local threshold. A seleção destes foi baseada na literatura junto à análise 

qualitativa (Figura 16). 
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Figura 16. Análise de auto local thresholds para imagens de reticulina. As áreas em branco 
correspondem ao o objeto de análise. 

 

Foi determinado o uso do auto local threshold denominado como Otsu 

(Figura 17A). Foram utilizados os valores padrões do software (radius = 15; 

parameter 1 = 0; paramater 2 = 0). O valor de radius utilizado foi de 15, onde 

ao se comparar o valor 3 com 15, ambos apresentaram resultado semelhante 

(Figuras 17B e 17C). 
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Figura 17. Teste de radius para fibras de reticulina. As áreas em branco correspondem ao objeto de 
análise. Legenda: A – Imagem pré-processada; B – Imagem segmentada com radius = 15; C – Imagem 
segmentada com radius = 3. 

 

5.3.3 Análise 

 A área fracionada das fibras de reticulina foi calculada pelo software 

ImageJ. 

O teste Shapiro-Wilk mostrou uma distribuição normal em todos os 

grupos (p>0,05). O teste One-Way ANOVA evidenciou diferença 

estatisticamente significante entre os grupos (p=0,045; F=3,67) e o teste de 

Lavene mostrou homogeneidade entre as variâncias (p=0,720). O teste post-

hoc de Turkey de comparações múltiplas não detectou diferença entre GA vs. 

GB (p=0,708; diferença de médias = -1,26%) e GB vs. GS (p=0,195; diferença 

de médias = -2,76%) porém, houve diferença entre GA vs. GS (p=0,042; 

diferença de médias = -4,02%) (Figura 18, Gráfico 4). 

 



R e s u l t a d o s  | 64 

 

 

 

 

Figura 18. Fibras de reticulina. As fibras de reticulina se apresentam com aspecto preto como o indicado 
pela seta amarela. Legenda: GA - Grupo de alta frequência; GB - Grupo de baixa frequência; GS - Grupo 

Sham. 
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Gráfico 3. Fração da área de fibras de reticulina por grupo. Legenda: GA - Grupo de alta frequência; 
GB - Grupo de baixa frequência; GS - Grupo Sham; CI – Intervalo de confiança. 
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6.0 DISCUSSÃO 

 

Os resultados deste estudo mostram que a TENS, de baixa e alta 

frequência e com intensidade sensorial, não influenciou na angiogênese, nem 

na proliferação celular; e, acarretou em inibição das fibras de reticulina do 

carcinoma de mama 4T1, quando utilizada a alta frequência. 

O carcinoma 4T1 tem como vantagens ser de fácil manuseio in vitro e 

in vivo e, deter características próximas ao câncer de mama em seres 

humanos, tais como o fato das metástases serem advindas do tumor primário 

e estas ocorrerem nos mesmos sítios quando comparados aos humanos 

(Pulaski e Ostrand-Rosenberg, 2001). 

Existem poucos trabalhos que avaliaram a influência da 

eletroestimulação em tumores (Jarm et al., 2003; Janigro et al., 2006; Linkov 

et al., 2012; Wang et al., 2018). Os resultados deste estudo corroboram com 

os trabalhos de Linkov et al. (2012) e Wang et al. (2018), em que correntes 

elétricas terapêuticas foram aplicadas sobre tumores e não houve influência 

destas na angiogênse e proliferação celular em tecidos tumorais. 

Por outro lado, Machado et al., (2016) mostraram que a TENS modulou 

a angiogênese e a reparação tecidual em ratos com lesões tegumentares 

excisionais agudas não tumorais. Os grupos experimentais ativos 

apresentaram aumento de densidade vascular nas fases iniciais da 

reparação, imediatamente pós-lesão; enquanto que, no 14° dia tinham uma 

densidade vascular inferior à do grupo controle. Portanto, se levarmos em 

conta que o microambiente tumoral é um ambiente de inflamação crônica 

(Onuchic e Chammas, 2011), não seria esperado que a TENS promovesse 

angiogênese. 

No que diz respeito à celularidade, a revisão narrativa de Love et al. 

(2018) mostra os efeitos de diferentes correntes elétricas na proliferação 

celular e apoptose nas mais variadas células (cancerígenas ou não). Os 

resultados, tanto para proliferação celular quanto para apoptose, são 
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inconclusivos, pois a estimulação elétrica pode inibir, estimular ou não alterar 

estas. Os autores recomendam que sejam realizados estudos para definir 

parâmetros ótimos para estes desfechos bem como para testar 

procedimentos mais eficazes, o que indica a importância de realizarmos 

estudos pré-clínicos que avaliem este desfecho. 

Linkov et al. (2012) ultilizaram uma corrente pulsada, bifásica e 

simétrica, assim como no presente estudo; porém, Linkov et al. (2012) 

realizaram uma NMES e, para isto, a intensidade utilizada foi motora, o que é 

uma importante diferença metodológica entre este trabalho e o presente 

estudo, uma vez que pesquisadores têm mostrado resultados distintos ao 

aplicar TENS com diferentes intensidades (Sherry et al., 2001; Cramp et al., 

2002; Liebano et al., 2006; 2008).  

Wang et al. (2018) aplicaram TENS sobre um câncer cervical (SiHa) 

em camundongos Balb/c nudes; porém, não especificaram as características 

físicas da corrente, ou seja, o tipo de corrente, quais os números de fases, 

balanço e simetria. 

A definição de TENS é muito abrangente. Segundo Jones e Jonhson 

(2009) é uma corrente elétrica terapêutica que estimula nervos abaixo do 

tecido tegumentar; porém, diversas características físicas das correntes 

elétricas terapêuticas acarretam em efeitos fisiológicos diferentes (Robertson 

et al., 2009), o que pode ser evidenciado ao comparar o presente estudo com 

o trabalho de Jarm et al. (2003), no qual houve redução do tamanho do tumor 

após aplicação de corrente direta. 

Wang et al. (2018) descrevem a frequência da corrente como 1/4/1 Hz 

e a duração de pulso de 230/270/230 µs, esta descrição pode indicar que a 

corrente utilizada foi modulada com variação de frequência e duração de 

pulso, mas isto não fica claro.  

A intensidade utilizada por Wang et al. (2018) foi de 20 mA de forma 

fixa. Este método de manter a intensidade com valores pré-estabelecidos é 

recorrente em estudos experimentais com TENS (Liebano et al., 2006; 

Machado et al., 2016); porém, é importante que a(s) fibra(s) nervosa(s) 
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excitada(s) seja(m) especificada(s), pois estas geram respostas fisiológicas 

diferentes (Liebano et al., 2006; Robertson et al., 2009). 

O trabalho de Liebano et al. (2006) mostrou que os animais tratados 

com 20 mA apresentaram fortes contrações musculares, portanto, é possível 

especular que os animais tratados por Wang et al. (2018) podem ter sido 

estimulados com intensidade motora e/ou dolorosa; porém, o ideal é que os 

autores mencionem isto, uma vez que a estimulação de diferentes fibras 

nervosas dependem da intensidade, duração de pulso, área de superfície do 

eletrodo e densidade de corrente (Liebano et al., 2006; Robertson et al., 2009).  

Outro ponto importante a ser destacado do trabalho de Wang et al. 

(2018) é que o tratamento foi de um único dia, porém, a avaliação do 

crescimento tumoral foi realizada ao longo de 28 dias. Esta aplicação única 

difere da maioria dos estudos experimentais sobre TENS (Liebano et al., 

2006; 2008; Machado et al., 2016; 2017), assim como da aplicação clínica 

deste recurso. Estas diferenças metodológicas entre o estudo de Wang et al. 

(2018) e o presente estudo, dificultam a comparação entre estes. 

Apesar de diferentes autores mostrarem os efeitos da TENS sobre fluxo 

sanguíneo, temperatura tecidual e reparação tecidual, os resultados deste 

estudo indicam que a TENS não teve influência sobre estes eventos, ou não 

os promoveu de tal forma que levasse a angiogênese e proliferação celular do 

carcinoma 4T1 (Indergrand e Morgan, 1994; Scudds et al., 1995; Cramp et al., 

2000; 2002; Sherry et al., 2001; Liebano et al., 2006; 2008; Machado et al., 

2016; 2017).  

Isto pode se dar pelo fato de o tratamento, no presente estudo, ter sido 

realizado com intensidade sensorial; sendo assim, não ocorreu o mecanismo 

de bomba muscular, que pode ser desencadeado pela estimulação elétrica de 

intensidade motora, produzindo substâncias que relaxariam o endotélio 

vascular, e aumentariam assim o fluxo sanguíneo (Scudds et al., 1995; Sherry 

et al., 2001; Cramp et al., 2002). Porém a atividade física é indicada para 

pacientes oncológicos, pois estudos apontam que esta reduz o risco, 
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recorrência e mortalidade de pacientes acometidos por câncer de mama (Xu 

e Rogers, 2020).  

A estimulação de intensidade sensorial também não deve ter gerado o 

reflexo axonal, uma vez que este é deflagrado pela estimulação de fibras 

nervosas Aδ e fibras C (Scudds et al., 1995). O reflexo axonal acarreta na 

liberação de neuropeptídeos que são potentes vasodilatadores como o CGRP 

e a SP (Khalil et al., 2001; Liebano et al., 2006; 2008; Machado et al., 2016). 

Uma forma de evitar a ocorrência do reflexo axonal, provocada por 

estímulos dolorosos intensos, e garantir que os animais fossem estimulados 

apenas com intensidade sensorial, foi excluir aqueles com lesões na 

epiderme; uma vez que isto pode acarretar em uma alteração da impedância 

e, assim, a passagem da corrente em tecido lesionado pode ativar fibras Aδ 

antes de estimular as fibras nervosas Aα (Liebano et al., 2006; Robertson et 

al., 2009). 

Estudos que avaliam os efeitos da TENS no fluxo sanguíneo mostram 

que este é aumentado ao se utilizar frequências baixas (Cramp et al., 2000; 

2002) e intensidades motoras (Sherry et al., 2001; Cramp et al., 2002; 

Sandberg et al., 2007). Estes resultados corroboram com o presente estudo, 

indicando que a TENS de alta frequência e intensidade sensorial é mais 

segura ao se estimular um tumor diretamente. 

Caso a TENS não promova aumento do fluxo sanguíneo, a nutrição das 

células tumorais não deve ser aumentada, seja de forma direta ou indireta 

(aumento da temperatura tecidual) (Scudds et al., 1995). Se a temperatura 

tecidual não for aumentada, é possível que não ocorra aumento do 

metabolismo local, uma vez que a lei de Van’t Hoff indica que, a cada 4°C 

adicionais, há um acréscimo de 50% do metabolismo (Robertson et al., 2009); 

e, assim, não haverá influência sobre a atividade mitótica das células tumorais 

(Rennie, 2011) por este mecanismo. 

O presente estudo evidenciou que a TENS de alta frequência promoveu 

uma inibição na deposição das fibras de reticulina. Este resultado pode ser 

interessante para o tratamento de pacientes oncológicos uma vez que 
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Shehata et al. (2004) mostraram que uma maior deposição dessas fibras 

podem ser um fator prognóstico importante para o crescimento tumoral 

induzido pelo TGF-β1. Junto disto, o trabalho de Wang et al. (2015) evidenciou 

uma inibição do TGF-β1 e do colágeno tipo III após estimulação elétrica de 

baixa intensidade no ramo auricular do nervo vago bem como uma diminuição 

da deposição de colágeno tipo III. 

O fato da TENS de alta frequência ter inibido a formação de fibras de 

reticulina pode se dar pela inibição da proliferação de colágeno tipo III, como 

o visto nos resultados de Folha et al. (2015) ao aplicar TENS em tendões; uma 

vez que as fibras de reticulina são formadas pela associação de colágeno tipo 

III e outros tipos de colágeno como o tipo V (Ushuki, 2002). 

Folha et al. (2015) justificam em seus resultados, a partir da lei de 

Arndt-Schultz, que a TENS pode ter sido utilizada em uma quantidade de 

energia excessiva a ponto de causar bioinibição do colágeno tipo I e III, sendo 

usada uma intensidade correspondente à 90% do limiar motor, portanto, uma 

intensidade sensorial. 

É possível que esta bioinibição tenha ocorrido na deposição de 

colágeno tipo III e, consequentemente, na formação das fibras de reticulina do 

carcinoma 4T1, pois a intensidade utilizada estava próxima ao limiar motor e 

ainda, a densidade de corrente usada variou de 3 a 6 mA/cm² uma vez que 

os eletrodos tinham 1 cm² de área. 

A inibição destas fibras não apresentou relação com a angiogênese e 

tampouco com a proliferação celular, o que pode indicar que, apesar de haver 

diferença estatisticamente significante entre GA e GS, com um tamanho de 

efeito absoluto de -4,02%, isto parece não ser o suficiente para gerar maiores 

repercursões no microambiente tumoral e, possivelmente, não seja 

clinicamente relevante. 

A TENS não trazendo malefícios para o paciente oncológico, poderia 

auxiliar no tratamento destes para o manejo da dor (Amaral et al., 2019), 

diminuição da dor pós-operatória junto à melhora funcional (Erden et al., 2022) 

e modulação da reparação tecidual pós-mastectomia (Atalay e Yilmaz, 2009; 
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Thakral et al., 2014), podendo ser um importante recurso na reabilitação 

destes. 

Estima-se que de 20% a 50% dos pacientes pós-cirúrgicos de câncer 

de mama cursem com dor (Tait et al., 2018) e, a dor pós-operatória intensa é 

um fator de risco para a cronificação da dor desta população (Okamoto et al., 

2018; Tait et al., 2018). A dor associada ao paciente sobrevivente de câncer 

de mama é um causador de estresse e, quando este não é manejado 

adequadamente tem impacto na qualidade de vida e sobrevida destes 

pacientes (Lin et al., 2023).   

Ainda compondo este quadro, o paciente pode apresentar LRCM e, 

com isso, ter uma sintomatologia de dor, encurtamento, sensação de peso, 

déficit de mobilidade e disfunção de membros superiores (Zhang et al., 2021). 

O LRCM também pode causar repercussões negativas nos pacientes 

acometidos, como um menor engajamento nas atividades de vida diárias e 

gerar impactos negativos na manutenção das atividades ocupacionais do 

indivíduo (Zhang et al., 2021).  

McLaughlin et al. (2017) recomendam a atividade física para estes 

pacientes uma vez que exercícios resistidos podem aumentar a força, diminuir 

a quantidade e intensidade de exacerbações do LRCM e exercícios aeróbicos 

são tidos como seguros para esta população. 

Os parâmetros utilizados para a TENS nesta pesquisa foram baseados 

em estudos prévios. São eles: a duração de pulso (Liebano et al., 2006; 2008; 

Yokoyama et al., 2015), o tempo de aplicação (Sato et al., 2012; Yokoyama et 

al., 2015) e o período de tratamento (Sato et al., 2012; Farcic et al., 2018). O 

método utilizado para a intensidade aplicada se baseou no trabalho de 

Yokoyama et al. (2012), onde a intensidade foi pré-estabelecida e foram 

realizados acréscimos para evitar a acomodação sensorial, a cada cinco 

minutos. 

As frequências de 10 e 100 Hz foram utilizadas por estas serem tidas 

como frequências baixa e alta respectivamente (Gibson et al., 2017); uma vez 

que são evidenciados diferentes resultados sobre o fluxo sanguíneo e a 
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modulação da reparação tecidual entre grupos de estudo de baixa e alta 

frequência (Scudds et al., 1995; Cramp et al., 2000; Machado et al., 2016; 

2017). 

Uma limitação deste estudo é o fato de a estimulação elétrica ter sido 

feita apenas com intensidade sensorial, não avaliando os impactos dos 

mecanismos de ação relacionados às intensidades motora e dolorosa sobre 

o tumor e, também, não foram avaliados os efeitos da TENS com frequências 

baixíssimas como 2 e 4 Hz para este tecido.  

Este estudo foi o primeiro a avaliar a influência da TENS na 

angiogênese, proliferação celular e fibras de reticulina do carcinoma de mama 

4T1, o que abre novas possibilidades para futuras pesquisas. 

O método desenvolvido para avaliar a proliferação celular a partir do 

uso de lâminas de HE, pode auxiliar em futuras pesquisas, uma vez que o uso 

destas lâminas é recorrente e acessível (Alwahaibi et al., 2012; Chan, 2014; 

Alturkistani et al., 2016). Junto disto, a análise foi automatizada por meio de 

macros (Anexo 3) para o software ImageJ, que é amplamente utilizado 

(Schindelin et al., 2015) e, desta forma, diminui a sobrecarga de 

pesquisadores. 

Pontos fortes a serem destacados consistem no uso racional da 

intensidade sensorial juntamente à exclusão de animais com lesões na 

epiderme para que não haja eletroestimulação dolorosa (Liebano et al., 2006); 

o período de tratamento longo para este tipo de lesão (Linkov et al., 2012; 

Wang et al., 2018); e o uso de lâminas de reticulina, que podem desempenhar 

um importante papel na progressão tumoral, o que não foi visto por estudos 

de desenho semelhante a este (Linkov et al., 2012; Wang et al., 2018). 

 Sugerimos que sejam estudados temas relativos aos efeitos da TENS 

no microambiente tumoral, como na expressão de VEGF, de diferentes 

marcadores inflamatórios (em especial citocinas pró-inflamatórias) e 

proliferação de células tumorais com marcadores específicos como o Ki-67.  
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Futuros estudos devem ser realizados a fim de elucidar o uso da TENS 

sobre tumores em animais que estejam sob quimioterapia, em diversos tipos 

de carcinomas e com diferentes parâmetros (principalmente com frequências 

baixas e intensidade motora); e também, os efeitos da TENS na disseminação 

de células tumorais e, consequentemente, em metástases. 
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7.0 CONCLUSÕES 

 

A TENS programada para emitir os parâmetros de duração de pulso de 

200 µs, frequências de 10 Hz ou 100 Hz, tempo de aplicação de 20 minutos e 

intensidade sensorial de 3,0 mA a 6,0 mA, por 10 dias não consecutivos de 

tratamento, durante duas semanas, não promoveu angiogênese e não teve 

efeitos na proliferação celular; porém, quando utilizada em alta frequência 

inibiu a formação de fibras de reticulina em pequena quantidade no carcinoma 

4T1. 
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ANEXO 2 

 

ADENDO PARA ANÁLISE DE MATERIAL COLETADO 

 

Ao Dr. Eduardo Pompeu, coordenador da Comissão de Ética no Uso 

de Animais (CEUA), 

 

Solicito adendo relativo ao material coletado, referência 040/15 

intitulado como: “Influência da Estimulação Elétrica Nervosa 

Transcutânea no crescimento de carcinoma 4T1 em glândula mamária 

de camundongos”, aprovado em 25/03/2015. 

Anteriormente foram realizadas análises de crescimento tumoral por 

meio de paquímetro digital e de área de necrose por meio da microscopia com 

lâminas de Hematoxilina e Eosina (HE). 

 As novas análises propostas são relacionadas ao crescimento tumoral, 

mantendo assim o título da pesquisa, sendo estas: análise de celularidade por 

meio de lâminas de HE, análise de tecido fibrótico por meio de lâminas de 

reticulina e análise de vasos saguíneos (imunohistoquímica) por meio de 

lâminas de HE + CD31. 

Para tal, solicito prorrogação de prazo até Maio de 2023.  

 

_________________________________________________________ 

Pesquisadora responsável: Profa. Dra. Raquel Aparecida Casarotto 

_________________________________________________________ 

Pesquisador Executante: Leonardo Affonso Massabki Caffaro 

 

São Paulo, 20 de Maio de 2019. 



A n e x o  | 92 

 

 

ANEXO 3 
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ANEXO 4 

 

A. Análise de área fracionada de impregnação por CD31 no software 

ImageJ para imuno-histoquímica 

 

• Image > Color > Colour Deconvolution 

• H&E DAB 

• Colour_3 

• Analyze > Set Measuraments 

• Area 

• Area fraction 

• Image > Adjust > Brightness/Contrast 

• Ajuste manual de mínimo, máximo e contraste 

• Apply 

• Image > Adjust > Auto Local Threshold 

• Otsu 

• 15 radius 

• Parameter 1 = 0 

• Parameter 2 = 0 

• Analyze > Measure 

 

a. Macro após ajuste de brilho e contraste 

 

run("Auto Local Threshold", "method=Otsu radius=15 parameter_1=0 

parameter_2=0"); 
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run("Measure"); 

close(); 

 

B. Análise de contagem de núcleos celulares e área fracionada de 

núcleos celulares no software ImageJ para lâminas de HE 

 

• Image > Adjust > Color Balance 

• 50% esquerdo do histograma de cor vermelha e azul 

• Analyze > Set Measures 

• Area 

• Fraction area 

• Shape description 

• Image > Type > RGB Stack 

• Image > Color > Arrange Channels 

• New channel order: 3 

• Process > Enhance Contrast 

• Saturated pixels: 0.35%  

• Equalize histogram 

• Process > Noise > Despeckle  

• Image > Adjust > Auto Local Threshold 

• Savoula 

• 15 radius 

• Parameter 1 = 0 

• Parameter 2 = 0 

• Process > Binary > Watershed 

• Analyze > Analyze Particles 
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• Size (pixel^2): 100-10.000 

• Circularity: (0.00-1.00) 

• Show: Outlines 

• Display results 

• Summarize 

• Add to Manager 

 

a. Macro após ajuste de balanço de cor: 

 

run("RGB Stack"); 

run("Arrange Channels...", "new=3"); 

run("Enhance Contrast...", "saturated=0.35 equalize"); 

run("Despeckle"); 

run("Auto Local Threshold", "method=Sauvola radius=15 parameter_1=0 

parameter_2=0"); 

run("Watershed"); 

run("Analyze Particles...", "size=100-10000 show=Outlines display 

summarize add"); 

 

C. Análise de área fracionada de impregnação argêntica para fibras 

de reticulina no software ImageJ para lâminas de reticulina 

 

• Image > Color > Colour Deconvolution 

• Masson Trichrome 

• Colour_1 

• Analyze > Set Measuraments 

• Area 
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• Area fraction 

• Image > Adjust > Brightness/Contrast 

• Ajuste manual de mínimo, máximo e contraste 

• Apply 

• Image > Adjust > Auto Local Threshold 

• Otsu 

• 15 radius 

• Parameter 1 = 0 

• Parameter 2 = 0 

• Analyze > Measure 

 

a. Macro após ajuste de brilho e contraste 

 

run("Auto Local Threshold", "method=Otsu radius=15 parameter_1=0 

parameter_2=0"); 

run("Measure"); 

close(); 

 


